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ABOUT NETQUIZ PRO

Netquiz Pro is an authoring tool for formative or summative quizzes1 which can be uploaded to the 
Internet. With Netquiz Pro it is possible to create eleven types of questions:

- Checkerboard matching
- Dictation 
- Essay 
- Fill in the blanks 
- Identifying parts of an image 
- Matching
- Multiple answer 
- Multiple choice 
- Sequencing
- Short answer
- True/False

These questions can comprise text, images, audio clips, video and Web hyperlinks. They can also be 
configured in different ways, according to your needs.
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You start by writing all your questions in the same file, and then you slide them into different quizzes. 
Each quiz can be customized: the welcome page, the appearance, the number of questions and their 
order, the display language, the type of quiz — formative or summative — and so on. You can open 
several Netquiz Pro files simultaneously and cut and paste your questions from one file to another.

To create the Web version of a quiz, you simply select a quiz folder in the Netquiz Pro window and 
press on a button. A directory containing all the HTML pages of the quiz will be created on your hard 
disk. Then all you need to do is upload this directory to a Web server.

On the Web site of the CCDMD, you can view two examples of quizzes created using Netquiz Pro. 
Choose Examples in the To learn more menu of the displayed Web page, then click on the example of 
your choice.

N.B. If you have already built quizzes with Netquiz3 software (the predecessor to Netquiz Pro), you can 
import them into Netquiz Pro 1.2 and later versions using the Import an .nq3 file command in the 
File menu (for more details, see Import an .nq3 file in the Menu Bar section).

QuickTime software is required to play the media files associated with certain questions.

__________
1 By default, formative quizzes comply with the SCORM standard. Therefore, a certain follow-up may be made of 

quiz takers' results (individual question grades and overall grades) when quizzes are integrated into a pedagogical 
platform operating under the SCORM specifications. Other, non SCORM-compatible types of quizzes (formative 
quizzes with results submitted to server or summative quizzes) permit a more detailed follow-up of quiz takers' 
answers (for more details, refer to the Quiz Properties section).
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HOW TO START

When starting up Netquiz Pro, a window asks you if you want to create a question bank or open an 
existing one.

The first time you use the program, click on Create. After you have written the name of the new question 
bank (e.g. My-bank-101), a directory of the same name is created on your disk. This directory contains 
the file My-bank-101.npro as well as a MEDIA folder. Files must always have an .npro extension in order 
to be read by Netquiz Pro. They must also always be placed in the same directory as the MEDIA folder 
because it is in this folder that the images, audio clips and videos for your questions will be gathered. If 
you have already created a question bank in a previous work session, click on Open and browse your 
hard disk to find the file.

The content of the Netquiz Pro files is displayed in a window that can be maximized or minimized by 
dragging the lower right hand corner of the window. The menu bar at the top of this window holds the 
File, Edit, Windows and Help menus. Refer to the Menu Bar help topic to learn about these menus.

In the following example, we have just created a question bank named My-bank-101. The Questions 
and Quizzes sections of the window are empty. Refer to the Composing a Question topic to find out 
more about the buttons in the Questions horizontal bar and to the Building a Quiz topic to find out more 
about the buttons in the Quizzes horizontal bar.
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MENU BAR

The Netquiz Pro menu bar at the top of the screen holds the File, Edit, Windows and Help menus.

File Menu

The File menu contains the management controls for the question bank.

New
The New… command lets you create a new bank of questions and quizzes. When you click on this 
command, a dialogue box opens asking you to write the name of the new bank and to choose where 
on your hard drive you want to save the files. A directory with the chosen name is created in the 
specified location. It contains the file for the bank (the bank's name followed by the .npro extension, 
e.g. My-bank-101.npro) and a folder called MEDIA in which images, audio clips and video sequences 
will automatically be stored. Normally, you should not modify this configuration because, ideally, the 
MEDIA folder should be located in the same directory as the question bank (.npro file). If this is not 
the case, a dialogue box will ask you to specify the location of the folder containing the media each 
time the bank is opened or while you are working.

Open
The Open… command lets you open a previously saved question bank. A standard dialogue box 
allows you to browse the contents of your different drives and to open an .npro extension file. When 
the Open… command is activated, the program checks if the MEDIA folder is in the same directory 
as the question bank (.npro file). If this is not the case, you must indicate the location of the MEDIA 
folder; otherwise, the media files will not appear in the questions. 

You can open several question banks at the same time and move from one to the other by clicking 
on their respective windows or by choosing a specific bank in the Windows menu. The menu 
commands only apply to the window of the active bank, i.e. the window in the foreground. When two 
question banks are open, you can Copy questions in one bank and Paste them in the other (refer to 
the Copy and Paste commands in the Edit Menu subsection further down.)

Close
The Close command lets you close the window of the active question bank (the one in the 
foreground if several windows are open). If you have made changes to the bank after opening it, you 
must specify if you want to save these changes before closing the window.

Save
The Save command lets you save changes made to the active question bank (the one in the 
foreground, if several windows are open). The name of a bank must not exceed 32 characters, 
including the .npro extension (e.g. My-bank-101.npro).
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Save as...
The Save As… command lets you save the active question bank in the foreground under a different 
name. The new name must not exceed 32 characters including the .npro extension (e.g. 
My-bank-101-copy.npro).

Importing an .nq3 file
The Import an .nq3 file command lets you import questions created with Netquiz 3 software, the 
predecessor of Netquiz Pro.  A standard dialogue box allows you to browse the contents of your 
disks and peripherals and to open a file with the .nq3 extension. Once you activate this command, 
the questions from the older files and their respective media files are added one by one to the active 
bank of questions.

If the questions created with Netquiz 3 contain HTML code entered directly into text fields (for 
example, hyperlinks to Websites or hyperlinks to images), you must erase them and then redo them 
with the functions offered in the Edit menu of Netquiz Pro (see Insert a Web link and Insert an image 
below).

Moreover, if the imported questions comprise GIF images, you must convert them to JPG (JPEG) 
format using a graphic editor such as Photoshop, for example, and redo the links within the 
questions, because Netquiz Pro does not support GIF format.

Results Management Module
You will need to use the Results Management Module command if you wish your summative or 
formative questionnaires with results submitted to server (see the Quiz Properties section) to be kept 
and processed at a Web server capable of supporting PHP language and MYSQL databases.
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In the window prompted by this command an instruction explains how to fill the "Database server 
address", “Database name”, “Database user name”, and “Database password” fields with the 
details that your network administrator will have provided to you. When you click <OK>, a directory 
under the name <administrator> will appear on your computer's desktop. This directory must be 
transferred to the server by using FTP transfer software. It will let you manage your quizzes and the 
quiz takers' answers (for more details, refer to the Putting a Quiz Online and Results Management 
Module sections).

Note: One management module will be enough to manage all your summative Web quizzes and 
formative Web quizzes with results submitted to server.

Print Format...
The Print Format… command prompts the printer dialogue box in which you can indicate the paper 
size and orientation (portrait or landscape).

Quit
The Quit command is used to exit Netquiz Pro. If changes have been made to any of the open 
question banks, you have to decide if these changes must be saved before closing their windows.

Edit Menu

The Edit menu contains the commands used to edit the different text fields in Netquiz Pro. Some of 
these commands also apply to the table containing the list of questions or to the zone containing the 
quiz folders.

Cancel
The Cancel command cancels the last operation done to a text field or erases the last characters 
written.

Cut
The Cut command acts differently depending on the active area. If the cursor is located in a text field 
and a portion of the text is selected, this command will remove the selected text. If one or several 
questions are selected in the question table, this command will delete them. A dialogue box will first 
ask you to confirm this operation because the deleted questions cannot be retrieved afterwards. If a 
quiz folder is selected in the quiz zone, the Cut command will delete it. Again, a dialogue box will ask 
you to confirm the operation before completing it.

Copy
The Copy command acts differently depending on the active area. If the cursor is located in a text 
field, this command will memorize the selected text in order to use it at a later time, e.g. to paste it in 
another Netquiz Pro text field or in other software (see the Paste command). If one or several 
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questions are selected in the question table, this command will keep in memory the content of the 
selected question(s). This operation lets you then Paste these questions (see the Paste command) 
in another question bank. If a quiz folder is selected in the quiz zone, the Copy command will 
remember the data of this quiz, which can then be duplicated in the same zone using the Paste 
command (N.B. unlike the questions, the quizzes cannot be cut and pasted from one question bank 
to another).

Paste
The Paste command acts differently depending on the active area. If the cursor is located in a text 
field, this command enters, at the cursor's location, the last portion of cut (Cut command) or copied 
text (Copy command) from another Netquiz Pro text field or other software. If you have copied 
questions from the question table using the Copy command, you can Paste these questions either 
in the same table-the equivalent to duplicating them-or in the table of another Netquiz Pro file (N.B. 
you must make sure to click on the appropriate question table for the Paste command to become 
active and apply to that table). If you have copied a quiz using the Copy command, you can “duplicate” 
it in the same file using the Paste command (N.B. unlike the questions, the quizzes cannot be cut 
and pasted from one question bank to another).

Select All
The Select All command selects the entire text in the text field being edited or all the questions in the 
question table.

The following commands are used to modify the style of a previously selected portion of text when 
editing a question or to insert a Web link or an image (N.B. certain text fields do not allow style changes 
or the insertion of a hyperlink or an image; in such a case the following commands will appear shaded 
in the Edit menu).

Normal
The Normal command is used to remove the style of the selected portion of text.

Bold
The Bold command is used to put in bold characters the selected portion of text.

Italic
The Italic command is used to put in italic characters the selected portion of text.

Strike Out
The Strike Out command is used to strike out the selected portion of text.

Superscript
The Superscript command puts the selected text into a superscript position.
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Subscript
The Subscript command puts the selected text into a subscript position.

Insert a Web link
When the Insert a Web link command is applied to selected text that can be modified in style, a box 
appears in which the selected text is reproduced in the Hyperlink text field. Enter a valid Internet 
address in the URL field next to http:// and click on the OK button. The selected phrase will become 
an actual link to the webpage in the Web version of the question. To remove a hyperlink, click on the 
underlined text, and delete the URL address in the Web link box.

N.B. Hyperlinks to Web sites should be avoided in summative quizzes.

Insert an Image
The Insert an image command lets you insert an image at the cursor insertion point in certain text 
fields that can accept changes in style. This command prompts a box in which you can choose an 
image type media files from the media list you have already imported to the MEDIA folder of the 
question bank.
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If the image you want to insert does not appear in this list, you can add it by clicking on the + button of 
the Media box. This button prompts a window which allows you to browse your hard drive to find the 
image and import it (by clicking on the Open button of the search window) in the MEDIA folder of your 
question bank. An identical Media box appears when you insert an image, an audio clip, or a video in 
the heading of a question or on the welcome page of a quiz (refer to the For All Types of Questions 
and Building a Quiz sections for more on this).

N.B. The following formats are supported by Netquiz Pro for imported image files: PICT, JPEG, BMP 
and PNG formats.

Windows Menu

If several question banks are open, you can go from one to the other by clicking on the desired window 
or by selecting the appropriate name in the Windows menu.

Help Menu

The Help menu comprises three commands: Netquiz Pro Help, Credits and Comments.

Netquiz Pro Help
The Netquiz Pro Help command prompts a window containing information on the different Netquiz 
Pro software functions. You can print the help section appearing onscreen by clicking on the printer 
icon button located in the lower left corner of the window. To print the entire help text, press on the 
SHIFT key when you click on the printer button.
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Credits
The Credits command prompts a window listing the organizations and people who have contributed 
to the production and creation of Netquiz Pro.

Comments
The Comments command lets you access a CCDMD Web page on which you can write your 
comments concerning Netquiz Pro and rate the program.
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COMPOSING A QUESTION

To compose, edit, delete, duplicate or print a question, you must be familiar with the use and 
functioning of the buttons on the Questions bar and on the table of the list of questions in the main 
Netquiz Pro window.

Buttons on the Questions Bar

On the Questions bar located at the top of the main Netquiz Pro window, you will find four buttons used 
to edit the questions.

+ Button (Adding a question)
The + button lets you add a question to the question bank of the active window. When you click on 
this button, a menu with the following list of types of questions appears: checkerboard matching, 
dictation, essay, fill in the blanks, identifying parts of an image, matching, multiple answer, multiple 
choice, sequencing, short answer, true/false. Click on the type of question of your choice. As soon as 
you release the button, the edit window for the question appears in the centre of the screen (for more 
details on editing a question, refer to the help section titled For All Types of Questions or to the 
sections discussing the types of questions you want to compose).
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When you close the edit window of the question, a line corresponding to the new question is added 
to the table of the list of questions (see the section titled Question List Table further down).

- Button (Deleting the selected question(s))
The - button lets you delete the selected question(s) in the question list table. Because this 
operation cannot be reversed, a dialogue box asks you, as a safety measure, to confirm the request 
for deletion.

Duplicate Button (Duplicating the selected question(s))
The button representing two superimposed pages lets you duplicate the selected question(s) in the 
question list table. Duplicating a question lets you quickly create a new question that has several 
properties similar to an already existing question in the question bank.

Print Button
The button representing a printer prompts a menu that lets you print the content of one of the 
following: the selected question(s), all the questions, or the question list table. In the case of this last 
option, a dialogue box will ask you to indicate which columns (Code, Title, Type of question, 
Weighting, Comment) you want to print.
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Question List Table

As you compose questions, they are added to the question list table of the active Netquiz Pro window.

To select a question, click on the corresponding line in the table. To select several questions, click 
successively on the different lines while maintaining the SHIFT or CTRL key down for Windows, or the 
SHIFT or APPLE key for a Mac OS. The selected questions are the ones appearing in bold characters in 
the list.

To modify the content of a question, double-click on the line for the question in the table. The editing 
window for the question will appear in the centre of the screen (for more details, refer to the For All 
Types of Questions section or to the sections discussing the types of questions that you want to 
compose).

To sort the table's content, click on one of the following headings: Code, to sort the questions by entry 
order (every question is automatically given a unique code by Netquiz Pro when it is first created); Title, 
to sort them in alphabetical order using the titles you have given them; Type of question, to sort them by 
type of question; Weighting, to sort them according to their grade value; Comment, to sort them by the 
alphabetical order of your written comments.

To modify a column's width in the question list table, click on a vertical separation line (the cursor's 
appearance will change to two small vertical lines with arrows pointing left and right) and drag it to the 
desired width.
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FOR ALL TYPES OF QUESTIONS

For all the types of questions, each edit window consists of two index tabs: the Properties tab, which 
lets you configure the question according to your needs, and the Edit tab, which lets you enter data for 
the question. The Web Preview button at the bottom of the window lets you see how the question 
appears when viewed with a browser (e.g. Explorer or FireFox on Windows or Safari on Mac OS X).

Properties Index Tab

The Properties index tab displays several parameters in the window that let you customize a question. 
The parameters under the purple horizontal line are specific to each type of question (for more details, 
see the sections relating to each type of question), while the ones above the line are shared by all the 
types of questions.

Question title
By default, Netquiz Pro assigns a name to each question, e.g. *Matching Question Q1 untitled. You 
can replace it by a more significant title that will let you identify the question more easily in the list of 
the Netquiz Pro window. This title does not appear anywhere in the Web version of the question.

Weighting
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By default, Netquiz Pro attributes a weighting of 1.0 to most types of questions, except for the 
Checkerboard Matching and Essay questions for which the most likely value is 0. You can change 
these values to those of your choice. You will also learn in the Building a Quiz section that it is 
possible to modify a question's weighting in a particular quiz without changing its value here. This 
can be useful if you are using the same question in several quizzes. Please note that if you give a 
value of more than 0 to a Checkerboard Matching or Essay question, the quiz takers will 
automatically receive 0 if they have not finished the checkerboard matching question or haven't 
written the essay. Moreover, they will receive the total points possible if they have finished the 
checkerboard matching question or written something in the answer section of the essay question.

Comment
The Comment field lets you write anything you choose. Because the text in this field appears in one 
of the columns of the question list table in the Netquiz Pro main window, you can use it to identify 
certain questions easily (e.g. incomplete questions, questions related to a particular chapter or quiz, 
or even questions intended for a specific classroom group). This comment does not appear 
anywhere in the Web version of the question.

Quizzes containing this question
The Quizzes containing this question menu cannot be edited. It lists the quizzes in which you have 
inserted this question if there are any (see the Building a Quiz section).

Display the answer
By default, the Display the answer box is ticked. This means the Answer button will be available in 
the floating menu of the Web version of the question. This will allow those who answer the question 
to find out the correct answer if they so desire.

Edit Index Tab

The Edit index tab displays different fields in the window which allow you to write a question. The way to 
enter answers and feedback differs from one type of question to the next (for more details, see the 
sections related to the individual types of questions). However, the fields at the top of the edit window 
are the same for all of them.
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Clues ans Source sections
In the top part of the window under the Edit tab, you will find two areas defined by an L shaped line 
and a small triangle. By default, Netquiz Pro writes No Clue and No Source in these two areas. If you 
do not want your Web question to display these headings, leave the text as is. If, however, you do 
want a clue or a source (or both) to appear, click on the respective area(s) and a box will appear to let 
you enter a title and some text.
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You can enter what you wish in the Title field, for example ”Here is a little clue”, “Reference”, “To 
learn more…,” etc. What you use these two sections for is up to you. They can be used for purposes 
other than giving a clue or a source; it depends on your needs. The text area in this window accepts 
changes in style. Refer to Edit Menu in the Menu Bar section to see how you can change the style or 
add Web links and images to this area.

In the Web version of the question, only the titles appear in the heading. The person answering the 
question must click on this title for the text to be displayed.

Image, Audio et Video icons
Under the Clue and Source sections, four icons are displayed. The first three are used to insert an 
Image, an Audio clip or a Video in the heading of the question heading. If you want to insert one or 
more of these media, click on the appropriate icon and click on the Choose option of the menu. A box 
will appear allowing you to select an image, an audio clip or a video from the list of media already 
imported to the MEDIA folder of your question bank. You can sort the media list by Name or Type by 
clicking on the heading of the table.
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If the image, audio clip or video that you want to insert does not appear in the list, you can add it by 
clicking on the + button of the Media box. The button prompts a window which lets you search for the 
media file on your hard drive and import it (by clicking on the Open button of the search window) to 
the MEDIA folder of your question bank.

N.B. The following formats are supported by Netquiz Pro for imported media files: for images, PICT, 
JPEG, BMP and PNG formats; for audio and video, MP3, MP4, MOV, AIFF, WAVE, MPEG, MID 
and AVI formats.

Text Icon
To the right of the Image, Audio and Video icons is a fourth icon allowing you to insert Text into the 
question's heading. The Title and Text input box is identical to the one described above under the 
Clue and Source sections heading. Unlike the text in the Clue and Source sections, the text you 
insert here will be visible in the heading of the Web version of your question above the statement (or 
question item). This icon is thus used to insert text that must be read before answering the question

Statement field
The Statement field is where you write the question item or statement. Please note that this does 
not mean describing how to technically answer the question because instructions related to each 
type of question are always available by clicking on the question mark (?) button in the Web version 
of the question (see the section below titled Web Preview of the Question).

Web Preview of the Question

To be able to see a Web preview of your question, you must have a browser installed on your computer 
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(e.g. Explorer or FireFox on Windows or Safari on Mac OS X). When clicking on the Web Preview button 
in the edit window of the question, a directory titled PREVIEW-WEB-TMP temporarily appears on your 
computer's desktop and the window of the Web question is displayed in the foreground. Once 
the edit window is closed, this directory automatically disappears. By default, the Web preview of 
a question appears with the Classic background. You will see in the Building a Quiz section that 
it is possible to modify the background of the questions in a given quiz (colour of the strip on the 
left, appearance of the floating menu and buttons, background image, etc.).

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.

The Web display for all of the questions consists of the name of the question type at the top, followed by 
a ? button, which prompts technical instructions on how to answer this type of question, and, in the top 
right corner, the question's weighting.

The headings for all types of questions may consist of any combination of the following elements or 
none of them: a clue section, a source section, an image, an audio clip, a video, a text, and a 
statement. These are followed by the items specific to each type of question (for more details, see the 
sections related to each type of question).

A floating menu located on the left side of the screen holds arrows to navigate from one question to the 
next if there is more than one. It also holds a Go to question box, in which you can write a question 
number followed by the ENTER (or the data entry) key. Finally, the floating menu also displays the 
following buttons: the Check button to get feedback on the answer given, the Answer button to find out 
the right answer (if the Display the answer option is enabled), the Reset button to clear the answer 
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fields or to restore them to random order, and the Results button to receive an assessment of the 
results of all the quiz questions.

The space at the bottom of the window is used to display the validation or the correct answer. The size 
of this section can be adjusted by placing the cursor on the horizontal line and by dragging it up or down.
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CHECKERBOARD MATCHING QUESTIONS

In checkerboard matching questions, quiz takers match item pairs in a checkerboard. These items can 
comprise either text or images. At the beginning, the checkerboard squares can be hidden or visible. 
Apart from the properties and editing zones common to all types of questions (see the section titled For 
All Types of Questions), checkerboard matching questions have the following characteristics:

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a checkerboard matching question.

Number of squares in the checkerboard
A checkerboard matching question comprises 4, 8, 12, 16 or 20 squares. You choose the number of 
squares in the Number of checkerboard squares pull-down menu.

Types of items to match
In the Types of items to match pull-down menu, you can choose between Text-Text, Text-Image, 
Image-Text and Image-Image. The first term defines the nature of the first item of the pair and the 
second term defines that of the second item of the pair.
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Type of item display 
In the Type of item display pull-down menu, you can choose between Hidden at the beginning and 
Visible at the beginning. In the first case, the checkerboard squares are hidden at the beginning and 
the quiz taker must uncover them by successively finding the items composing a pair. The exercise 
in this case resembles a memory game. In the second case, the checkerboard squares are visible 
at the start of the quiz and the quiz taker must hide them by successively finding the items 
composing a pair. The exercise resembles an matching game. 

Background colour of the first and second items
By default, the selected background colour is white. From the pull-down menus, you can choose a 
background colour from the following list: White, Grey, Blue, Yellow, Red, or Green. Please note, 
however, that the background colour can only be used for text items, not for images. This option is 
particularly useful to differentiate between two types of items to pair in a checkerboard that is visible 
at the beginning (e.g. matching terms on a yellow background to definitions on a red background).

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays three columns: the first 
two columns allow you to enter the contents of the items to match and the third lets you choose the 
image used as a mask.
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First item and Second item columns
The First and Second item columns can contain text or images according to the choice made for the 
Types of items to match in the Properties of the question window.

If one of these columns contains text, you need only enter this text. Any characters with an ASCII code 
higher than 255 will not be accepted. Moreover, you should avoid the following special characters: ', 
", <, > because they have a specific meaning for Web pages. Because the Web version of 
checkerboard matching questions uses Flash software to display the items, no change in style is 
permitted for these two columns.

If one of these columns contains images, you need only click in the rectangle to display a dialogue 
box that will allow you to choose an image from the list of media already imported to the MEDIA folder 
of the question bank. If the image that you wish to insert is not found in this list, you can add it by 
clicking on the + button of the Media dialogue box. Clicking this button prompts a window that allows 
you to find the image on your hard drive and import it into the MEDIA folder of your question bank by 
clicking on the Open button. An identical Media dialogue box will appear when you insert an image, 
an audio clip or a video into the heading of a question or into the welcome page of a quiz (see the For 
All Types of Questions and Building a Quiz headings).

Mask image
The Mask image column contains the images to be used as masks in each of the boxes. The items 
in this column already contain default images which you can change at your leisure. Inserting a 
mask image is similar to inserting an image in the other column; you need only click in the rectangle 
to display the Media box (see the previous section).

Web Preview of the Question

Here is an example of the Web preview of a checkerboard matching question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.
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Display of the answer verification
When a quiz taker clicks on the Check button in the floating menu before having finished matching 
the items, an Incomplete answer message will appear in the check zone at the bottom of the screen 
page. If the checkerboard is complete, Correct answer will be displayed.

The following example shows a checkerboard visible at the beginning. The squares become hidden 
as the quiz taker matches the right items.
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Display of the answer
When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 
displayed as follows in the lower half of the screen page: the word Answer followed by the correct 
answer for each matching pair of the checkerboard.
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DICTATION QUESTIONS

In dictation questions, quiz takers listen to an audio or video clip at their own pace and transcribe what 
they hear in a text field. Apart from the properties and editing zones common to all types of questions 
(see the section titled For All Types of Questions), dictation questions have the following characteristics: 

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a dictation question.

Marks subtracted for spelling mistakes
By default, the number of points subtracted for each word misspelled is 0.05. You can change this 
value at will. It is important to adjust the weighting to take into account the number of words in the 
dictation. This avoids giving, for example, a mark of 0 to a student who has made only one mistake in 
a long dictation or a mark of 9.0 / 10.00 for a sentence in which nothing is right!

Punctuation and capital/small letters
The following two elements can be taken into account when correcting a dictation: punctuation and 
capital/small letters. Tick these options if you want these kinds of mistakes to be recorded when the 
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dictation is being corrected.

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays three text zones in 
which you can enter the solution of the dictation as well as positive and negative feedback. But first, 
here are a few suggestions since a dictation requires an audio source to dictate the text.

Dictation audio source
You can insert the audio source for the dictation using the Audio or Video icons in the heading of the 
question (for further instructions, see the Image, Audio and Video icons section of the For All Types of 
Questions rubric).
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You can also insert a Web link in the Statement that points to a site hosting the audio or video clip 
for the dictation (see the Insert a Web link section of the Menu Bar rubric for more on this).

Dictation solution
The Dictation solution text field lets you write the text that will be used to correct the dictation. Please 
note that style changes cannot be made in this text field. Any characters with an ASCII code higher 
than 255 will not be accepted. Moreover, you should avoid the following special characters: ', ", <, > 
because they have a specific meaning for Web pages.

N.B. In order to avoid anomalies that interfere with the performance of the correction algorithm, you 
should use short dictations. A long text can be easily subdivided into short excerpts that are 
each the object of a separate dictation question.

It is not recommended to use dictation questions in a summative quiz because the correction 
algorithm will give 0 as a grade if it encounters too many anomalies.

 

Positive and Negative feedback
The Positive and Negative feedback text fields are used to enter pertinent feedback other than 
Correct answer or Incorrect answer since either one of these is automatically given to the user 
when an answer is checked, whether or not other feedback exists. This text zone accepts changes in 
style. In the Edit Menu of the Menu Bar section, check how you can change a style or add Web links 
and images in this zone.

Web Preview of the Question
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Here is an example of the Web preview of a dictation question. In this example, the Source is, of 
course, optional but it shows the possibility of adding a hyperlink to a Web site in a text field.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.

Display of the answer verification
When quiz takers click on the Check button in the floating menu, they receive feedback according to 
what they have written in the input field of the dictation: 

- If they have written nothing, Incomplete answer will appear in the lower part of the screen page.

- If the dictation has no mistakes, Correct answer will appear in green followed by positive 
feedback if any has been provided.

- If there are mistakes in the dictation, Incorrect answer will appear in red followed by negative 
feedback if any has been provided. There will also be red marks indicating words wrongly 
spelt, words missing (underlined) and superfluous words (between brackets).
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Display of the answer
When the quiz taker clicks on the Check or Answer buttons in the floating menu, the correct dictation 
text is displayed in the lower half of the screen page under the word Answer.
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ESSAY QUESTIONS

In essay questions, quiz takers write their own answer to a question or express themselves on a given 
subject. Apart from the properties and editing zones common to all types of questions (see the section 
titled For All Types of Questions), essay questions have the following characteristics: 

Properties Index Tab

This type of question only has properties common to all types of questions.

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays one text zone in which 
you can enter a suggested answer.
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Suggested answer
The Suggested answer text field lets you write a comment or answer that the quiz takers can 
compare to their own answer when they click on the Check or Answer buttons of the floating menu 
(see the Web Preview of the Question section below). Any characters with an ASCII code higher than 
255 will not be accepted. Moreover, you should avoid the following special characters: ', ", <, > 
because they have a specific meaning for Web pages. This text zone accepts changes in style. In the 
Edit Menu of the Menu Bar section, check how you can change a style or add Web links and images 
in this zone.

Web Preview of the Question

Here is an example of the Web preview of an essay question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.
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Display of the answer verification and of the answer
When the quiz takers click on the Check or Answer buttons in the floating menu, they see the 
suggested answer displayed in the lower half of the screen page under the word Answer. To check 
their answer, the quiz takers must then compare their own answer with this suggested one.
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FILL IN THE BLANKS QUESTIONS

In fill in the blanks questions, quiz takers complete a text by writing in the missing expressions or 
words. Apart from the properties and editing zones common to all types of questions (see the section 
titled For All Types of Questions), fill in the blanks questions have the following characteristics:

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a fill in the blanks question.

Types of fill in the blanks texts
There are two possible ways of creating fill in the blanks texts: with or without a menu offering a 
choice of answers (see below the section titled Web Preview of the Question). In the first case, the 
quiz takers must, for each gap in the text, click on a pull-down menu which offers them a choice of 
answers. In the second case, there is no pull-down menu and the quiz takers must write their 
answer in the text field of each gap or, if the Display list of answers at the bottom of the screen 
option is ticked, they must copy the displayed expressions and paste them in the appropriate text 
fields.
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Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays a Text field which can 
be edited and a + button which lets you create gaps

Text field
The Text field is used to enter the complete fill in the blanks text. Any characters with an ASCII code 
higher than 255 will not be accepted. Moreover, you should avoid the following special characters: ', 
", <, > because they have a specific meaning for Web pages. This text zone accepts changes in style. 
In the Edit Menu of the Menu Bar section, check how you can change a style or add Web links and 
images in this zone.

+ Button
The + button lets you insert a gap to replace a selected expression. As soon as you add a gap, an 
input window adapted to the type of fill in the blanks text appears.

- Input window for a gap with a choice-of-answer menu 
The answer input window of a text gap with a menu offering a choice of answers comprises the 
three following zones: Correct answer, Choice of incorrect answers and Feedback. When the 
cursor is placed in the Correct answer field, text written in this field will also appear next to the 
word Feedback. You can then write feedback relating to the correct answer. To add an incorrect 
answer, you must click on the + button. By doing this, the text Incorrect answer 1 will appear 
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both in the incorrect answer table and next to the word "feedback." When you modify text in the 
table, the changes also occur next to the word "feedback." The Feedback box is then ready to 
accept feedback text for the selected incorrect answer. To delete an incorrect answer, you must 
select it in the table and click on the - button. In the Web version of the question, the 
choice-of-answers list of the pull-down menu of the gap will consist of the correct answer and 
of all the incorrect answers placed in random order.

- Input window for a text gap without a choice-of-answer menu 
The answer input window of a text gap without a menu offering a choice of answers resembles 
the input window described in the previous section. However, the table to the left is titled 
Predicted incorrect answers instead of Choice of incorrect answers, and a new zone titled 
Feedback for incorrect answers not predicted is added. For each text gap not having a choice 
of answers, the quiz takers must now write an answer themselves instead of choosing one 
from a pull-down menu. As with short answer questions, you can enter predicted incorrect 
answers and their respective feedback as well as general feedback for all other incorrect 
answers.
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Web Preview of the Question

Here are two examples of the Web preview of a fill in the blanks question. The first corresponds to a fill 
in the blanks text with a menu offering a choice of answers, and the second to a fill in the blanks text 
without a menu offering a choice of answers

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.
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Display of the answer verification
When the quiz taker clicks on the Check button in the floating menu, he or she sees Correct answer 
in green or Incorrect answer in red. Then, for each of the text gaps, a green or red dot indicates 
whether or not the answer is correct, and a reminder of the contents of the quiz taker's answer is 
displayed as well as appropriate feedback, if any has been entered for this answer.

Display of the answer
When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 
displayed as follows: the word Answer followed by the fill in the blanks text complete with the correct 
answers for each gap in bold characters.
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IDENTIFYING PARTS OF AN IMAGE QUESTIONS

In identifying parts of an image questions, quiz takers identify components of an image. Apart from the 
properties and editing zones common to all types of questions (see the section titled For All Types of 
Questions), identifying parts of an image questions have the following characteristics:

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize an identifying parts of image question.

Number of parts to identify
The minimum number of parts to identify is two, the default number appearing in the Number of 
parts to identify box. An identifying parts of an image question can comprise between 2 and 99 
items to identify. Please note, however, that a large number of items can have two drawbacks: first, it 
can slow down the display speed of the question's editing zones when you press on the Edit tab of 
this window, and second, it can make it difficult to manipulate the labels corresponding to the parts 
to identify in the Web version of the question. 

Types of parts to identify
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Dans le menu déroulant «Type de zones à identifier», vous pouvez choisir entre «Texte» et «Image», 
selon la nature des zones que vous désirez faire identifier.

Types of labels
In the Types of labels pull-down menu, you can choose between Alphabetical and Numerical. The 
end result will be a letter or number placed before each part to identify.

Presentation order of the parts to identify
By default, the presentation order of the parts to identify in the Web version of the question is random. 
If you want to specify a predetermined order, click on Predetermine and place in the desired order 
the alphabetical or numerical labels located in the box to the right of the Predetermine option.

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays three columns in which 
you can enter the content and respective positive and negative feedback of the parts to identify.

Parts to identify column
The Parts to identify column can contain text or images according to the choice made for the Types 
of parts to identify in the Properties of the question window. If the column contains text, you need 
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only write the text. Any characters with an ASCII code higher than 255 will not be accepted. Moreover, 
you should avoid the following special characters: ', ", <, > because they have a specific meaning for 
Web pages. This text zone accepts changes in style. In the Edit Menu of the Menu Bar section, check 
how you can change a style or add Web links and images in this zone.

If this column contains images, you need only click in the rectangle to display a dialogue box that will 
allow you to choose an image from the list of media already imported in the MEDIA folder of the 
question bank. If the image that you wish to insert is not found in this list, you can add it by clicking on 
the + button of the Media dialogue box. Clicking this button will display a window that allows you to 
find the image on your hard drive and import it into the MEDIA folder of your question bank by clicking 
on the Open button. An identical Media dialogue box will appear when you insert an image, an audio 
clip or a video into the heading of a question or into the welcome page of a quiz (see the For All 
Types of Questions and Building a Quiz headings).

Positive and Negative feedback columns
The Positive and Negative feedback columns are used to enter an explanation or pertinent 
feedback other than Correct answer or Incorrect answer since either one of these is automatically 
given to the user when an answer is checked, whether or not other feedback exists. This text zone 
accepts changes in style. In the Edit Menu of the Menu Bar section, check how you can change a 
style or add Web links and images in this zone.

Web Preview of the Question

Here is an example of the Web preview of an identifying parts of an image question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.
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Display of the answer verification
When a quiz taker clicks on the Check button in the floating menu, he or she sees at the bottom of 
the screen page: Correct answer in green or Incorrect answer in red. Then, for each part to identify, 
a green or red dot indicates whether or not the label is placed in the right place on the image, and a 
reminder of the contents of the part is displayed as well as positive or negative feedback if any has 
been entered.

Display of the answer
When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 



18/06/09 10:06 Page 45

displayed as follows in the lower half of the screen page: the word Answer followed by the image in 
which the labels are placed in the right spots.
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MATCHING QUESTIONS

In matching questions, quiz takers match items in a first column to items in a second column. Items in 
the same column can comprise either text or pictures. Apart from the properties and editing zones 
common to all types of questions (see the section titled For All Types of Questions), matching 
questions have the following characteristics: 

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a matching question.

Number of pairs to match
A matching question comprises between 2 and 15 pairs. Please note, however, that manipulating a 
large number of matched pairs can be difficult in the Web version of the question.

Types of pairs to match
In the Types of pairs to match pull-down menu, you can choose between Text-Text, Text-Image, 
Image-Text and Image-Image. The first term defines the nature of the items in the first column and 
the second term defines that of the items in the second column for matching questions.
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Types of labels
In the Types of labels pull-down menu, you can choose between None, Alphabetical and Numerical. 
The end result will be a letter, a number or nothing before each matching pair.

Presentation order of the items in the second column
In the Web version of this question (see the Web Preview section below for this question), the items 
in the left column will always appear in the same order you entered them (see the Edit Index Tab 
section below). However, the items in the right column will appear either in a random or a 
predetermined order depending on what you tick. To indicate a predetermined order, place 
alphabetical or numerical labels beside each item. These labels are located in the box to the right of 
the Predetermine option.

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays four columns in which 
you can select the content and respective feedback of the matching pairs.

First item and Second item columns
The First and Second item columns can contain text or images according to the choice made for the 
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Types of pairs to match in the Properties of the question window. 

If one of these columns contains text, you need only enter this text. Any characters with an ASCII code 
higher than 255 will not be accepted. Moreover, you should avoid the following special characters: ', 
", <, > because they have a specific meaning for Web pages. Because the Web version of matching 
questions uses Flash software to display the items, no change in style is permitted for these two 
columns.

If one of these columns contains images, you need only click in the rectangle to display a dialogue 
box that will allow you to choose an image from the list of media already imported to the MEDIA folder 
of the question bank. If the image that you wish to insert is not found in this list, you can add it by 
clicking on the + button of the Media dialogue box. Clicking this button will display a window that lets 
you find the image on your hard drive and import it into the MEDIA folder of your question bank by 
clicking on the Open button. An identical Media dialogue box will appear when you insert an image, 
an audio clip or a video into the heading of a question or into the welcome page of a quiz (see the For 
all types of questions and Building a Quiz sections).

Positive and Negative feedback columns
The Positive and Negative feedback columns are used to enter an explanation or pertinent 
feedback other than Correct answer or Incorrect answer since either one of these is automatically 
given to the user when an answer is checked, whether or not other feedback exists. Incorrect 
answer for a matching question is displayed when the second item (from the right column) is placed 
in the wrong spot. This text zone accepts changes in style. In the Edit Menu of the Menu Bar section, 
check how you can change a style or add Web links and images in this zone.

Web Preview of the Question

Here is an example of the Web preview of a matching question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.
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Display of the answer verification
When a quiz taker clicks on the Check button in the floating menu, he or she sees Correct answer 
in green or Incorrect answer in red. Then, for each matching pair, a green or red dot indicates 
whether or not the match is correct, and a reminder of the contents of the pair matched by the quiz 
taker is displayed as well as positive or negative feedback if any has been entered for this particular 
pair.

Display of the answer
When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 
displayed as follows in the lower half of the screen page: the word Answer followed by the correct 
answer for each matching pair.
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MULTIPLE ANSWER QUESTIONS

In multiple answer questions, quiz takers choose more than one answer from among several choices. 
Apart from the properties and editing zones common to all types of questions (see the section titled For 
All Types of Questions), multiple answer questions have the following characteristics:

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a multiple answer question.

Number of answer choices
The minimum number of answer choices is two, which is the default number appearing in the 
Number of answer choices box. A multiple answer question can comprise between 2 and 99 
choices. Please note, however, that a large number of choices can slow down the display speed of 
the question's editing zones when you press on the Edit tab of this window.

Types of answer choices
In the Types of answer choices pull-down menu, you can choose between Text and Image 
depending on the nature of the choices you want to submit to the quiz taker.
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Types of labels
In the Types of labels pull-down menu, you can choose between None, Alphabetical and Numerical. 
The end result will be a letter, a number or nothing before each answer choice.

Presentation order of the answer choices
By default, the presentation order of the answer choices in the Web version of the question is 
random. If you want to specify a predetermined order, click on Predetermine and place the 
alphabetical or numerical labels in the box located to the right of the Predetermine option in the 
desired order.

All the correct answers or at least one
At the bottom of the Properties window of the multiple answer question, you have the choice 
between two options: you can require that quiz takers provide all the correct answers (default 
option), or at least one correct answer among the provided choices.

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays a column in which you 
can write all the possible correct answers as well as two columns for indicating the content and 
respective feedback of the answer choices.
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Answer column
The Answer column contains check box buttons. You must indicate the all the possible correct 
answers by clicking on the appropriate buttons.

Answer choices column
The Answer choices column can contain text or images depending on the choice made under 
Types of answer choices in the Properties window of the question.

If the column contains text, you need only write the text. Any characters with an ASCII code higher than 
255 will not be accepted. Moreover, you should avoid the following special characters: ', ", <, > 
because they have a specific meaning for Web pages. This text zone accepts changes in style. In the 
Edit Menu of the Menu Bar section, check how you can change a style or add Web links and images 
in this zone.

If this column contains images, you need only click in the rectangle to display a dialogue box that will 
allow you to choose an image from the list of media already imported to the MEDIA folder of the 
question bank. If the image that you wish to insert is not found in this list, you can add it by clicking on 
the + button of the Media dialogue box. Clicking this button will display a window that allows you to 
find the image on your hard drive and import it into the MEDIA folder of your question bank by clicking 
on the Open button. An identical Media dialogue box will appear when you insert an image, an audio 
clip or a video into the heading of a question or into the welcome page of a quiz (see the For All 
Types of Questions and Building a Quiz sections).
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Feedback Column
The Feedback column is used to enter an explanation or pertinent feedback other than Correct 
answer or Incorrect answer since either one of these is automatically given to the user when an 
answer is checked, whether or not other feedback exists. This text zone accepts changes in style. In 
the Edit Menu of the Menu Bar section, check how you can change a style or add Web links and 
images in this zone.

Web Preview of the Question

Here is an example of the Web preview of a multiple choice question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.

Display of the answer verification
When a quiz taker clicks on the Check button in the floating menu, he or she sees: Correct answer 
in green or Incorrect answer in red. Then, for each of the answers, a green or red dot indicates 
whether or not the answer is correct, and a reminder of the contents of this answer is displayed as 
well as feedback, if any has been entered for this choice.
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Display of the answer
When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 
displayed as follows: the word Answer followed by all the possible correct answers.
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MULTIPLE CHOICE QUESTIONS

In multiple choice questions, quiz takers choose one answer from among several. Apart from the 
properties and editing zones common to all types of questions (see the section titled For All Types of 
Questions), multiple choice questions have the following characteristics:

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a multiple choice question.

Number of answer choices 
The minimum number of answer choices is two, which is the default number appearing in the 
Number of answer choices box. A multiple choice question can comprise between 2 and 99 
choices. Please note, however, that a large number of choices can slow down the display speed of 
the question's editing zones when you press on the Edit tab of this window.

Types of answer choices
In the Types of answer choices pull-down menu, you can choose between Text and Image 
depending on the nature of the choices you want to submit to the quiz taker.
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Types of labels
In the Types of labels pull-down menu, you can choose between None, Alphabetical and Numerical. 
The end result will be a letter, a number or nothing before each answer choice.

Presentation order of the answer choices
By default, the presentation order of the answer choices in the Web version of the question is 
random. If you want to specify a predetermined order, click on Predetermine and place the 
alphabetical or numerical labels in the box located to the right of the Predetermine option in the 
desired order.

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays a column for you to 
write the answer as well as two columns for the content and respective feedback of the answer choices.

Answer column
The Answer column contains radio buttons. You must indicate the correct answer by clicking on the 
appropriate button
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Answer choices column
The Answer choices column can contain text or images depending on the choice made under 
Types of answer choices in the Properties window of the question.

If the column contains text, you need only write the text. Any characters with an ASCII code higher than 
255 will not be accepted. Moreover, you should avoid the following special characters: ', ", <, > 
because they have a specific meaning for Web pages. This text zone accepts changes in style. In the 
Edit Menu of the Menu Bar section, check how you can change a style or add Web links and images 
in this zone.

If this column contains images, you need only click in the rectangle to display a dialogue box that will 
allow you to choose an image from the list of media already imported to the MEDIA folder of the 
question bank. If the image that you wish to insert is not found in this list, you can add it by clicking on 
the + button of the Media dialogue box. Clicking this button will display a window that lets you find the 
image on your hard drive and import it into the MEDIA folder of your question bank by clicking on the 
Open button. An identical Media dialogue box will appear when you insert an image, an audio clip or 
a video into the heading of a question or into the welcome page of a quiz (see the For All Types of 
Questions and Building a Quiz sections).

Feedback Column
The Feedback column is used to enter an explanation or pertinent feedback other than Correct 
answer or Incorrect answer since either one of these is automatically given to the user when an 
answer is checked, whether or not other feedback exists. This text zone accepts changes in style. In 
the Edit Menu of the Menu Bar section, check how you can change a style or add Web links and 
images in this zone.

Web Preview of the Question

Here is an example of the Web preview of a multiple choice question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.
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Display of the answer verification
When a quiz taker clicks on the Check button in the floating menu, he or she sees Correct answer 
in green or Incorrect answer in red. Then a green or red dot indicates whether or not the answer is 
correct, and a reminder of the contents of the answer chosen by the quiz taker is displayed as well 
as feedback, if any has been entered for this choice of answer.

Display of the answer
When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 
displayed as follows: the word Answer followed by the correct answer.
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SEQUENCING QUESTIONS

In sequencing questions, quiz takers place items in order. These items can comprise either text or 
pictures. Apart from the properties and editing zones common to all types of questions (see the section 
titled For All Types of Questions), sequencing questions have the following characteristics:

Properties Indes Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a sequencing question.

Number of items to put in order
A sequencing question comprises between 2 and 15 items to put in order. Please note, however, 
that manipulating too great a number of items can be difficult in the Web version of the question.

Types of items to put in order
In the Types of items to put in order pull-down menu, you can choose between Text and Image 
depending on the nature of the items you want placed in order.
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Types of labels
In the Types of labels pull-down menu, you can choose between Alphabetical and Numerical. The 
end result will be a letter or a number before each item to be put in order.

Presentation order of the items to be put in order
By default, the presentation order of the items to be placed in order in the Web version of the 
question is random. If you want to specify a predetermined order, click on Predetermine and place in 
the desired order the alphabetical or numerical labels located in the box to the right of the 
Predetermine option.

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays three columns in which 
you can enter the content and respective positive and negative feedback of the items to order.

Column for items in the right order
The Column for items in the right order can contain text or images according to the choice made for 
the Types of items to put in order in the Properties window of the question. If the column contains 
text, you need only write the text. Any characters with an ASCII code higher than 255 will not be 
accepted. Moreover, you should avoid the following special characters: ', ", <, > because they have a 
specific meaning for Web pages. Because the Web version of sequencing questions uses Flash 
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software to display the items, no change in style is permitted for this column.

If this column contains images, you need only click in the rectangle to display a dialogue box that will 
allow you to choose an image from the list of media already imported to the MEDIA folder of the 
question bank. If the image that you wish to insert is not found in this list, you can add it by clicking on 
the + button of the Media dialogue box. Clicking this button will display a window that allows you to 
find the image on your hard drive and import it into the MEDIA folder of your question bank by clicking 
on the Open button. An identical Media dialogue box will appear when you insert an image, an audio 
clip or a video into the heading of a question or into the welcome page of a quiz (see the For All 
Types of Questions and Building a Quiz sections).

Positive and Negative feedback columns
The Positive and Negative feedback columns are used to enter an explanation or pertinent 
feedback other than Correct answer or Incorrect answer since either one of these is automatically 
given to the user when an answer is checked, whether or not other feedback exists. This text zone 
accepts changes in style. In the Edit Menu of the Menu Bar section, check how you can change a 
style or add Web links and images in this zone.

Web Preview of the Question

Here is an example of the Web preview of a sequencing question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.
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Display of the answer verification
When a quiz taker clicks on the Check button in the floating menu, he or she sees Correct answer 
in green or Incorrect answer in red at the bottom of the screen page. Then, for each item put in 
order, a green or red dot indicates whether or not the order of the item is correct, and a reminder of 
the contents of the item is displayed as well as positive or negative feedback if any has been entered.

Display of the answer
When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 
displayed as follows in the lower half of the screen page: the word Answer followed by the content of 
each item placed in the right order.
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SHORT ANSWER QUESTIONS

In short answer questions, quiz takers write a short answer to a given question. Apart from the 
properties and editing zones common to all types of questions (see the section titled For All Types of 
Questions), short answer questions have the following characteristics:

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a short answer question.

Predicted number of incorrect answers
In a short answer question, quiz takers type in text to answer the question. This text must correspond 
exactly to the Correct answer you have written in the Edit window of the question. If the answer is not 
exactly the same, an error message will appear with feedback, if there is any. If a certain number of 
errors of the quiz takers are predictable and you wish to adapt feedback to each of them, all you have 
to do is write the number of predictable errors in the Predicted number of incorrect answers box. A 
short answer question can comprise between 0 and 99 predicted incorrect answers. Please note, 
however, that too great a number can slow down the display speed of the question's editing zones 
when you press on the Edit tab of this window.



18/06/09 10:06 Page 67

Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays two columns: one for 
entering both correct and predicted incorrect answers and the other for entering respective feedback.

Answer column
In the Answer column, you must first write the exact answer the quiz taker should write, followed by 
each of the predicted incorrect answers. Please note that style changes are not permitted in this 
column because quiz takers must write exactly what you have written in these text fields to receive 
appropriate feedback.

Feedback column
The Feedback column is used to enter an explanation or pertinent feedback other than Correct 
answer or Incorrect answer since either one of these is automatically given to the user when an 
answer is checked, whether or not other feedback exists. You will notice that by default, feedback 
(Unknown Error) is already provided for all errors quiz takers might make other than the ones you 
have provided for in the Answer column. You can change this feedback to suit your needs. This text 
zone accepts changes in style. In the Edit Menu of the Menu Bar section, check how you can change 
a style or add Web links and images in this zone.
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Web Preview of the Question

Here is an example of the Web preview of a short answer question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.

Display of the answer verification
When a quiz taker clicks on the Check button in the floating menu, he or she sees Correct answer 
in green or Incorrect answer in red. Then a green or red dot indicates whether or not the answer is 
correct, and a reminder of the contents of the answer chosen by the quiz taker is displayed as well 
as feedback, if any has been entered for this choice of answer.

Display of the answer
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When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 
displayed as follows: the word Answer followed by the correct answer.
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TRUE/FALSE QUESTIONS

In true/false questions, quiz takers answer a question using a simple dichotomic choice. Apart from the 
properties and editing zones common to all types of questions (see the section titled For All Types of 
Questions), true/false questions have the following characteristics:

Properties Index Tab

Under the purple horizontal line in the lower part of the window, the Properties index tab displays 
several parameters that let you customize a true/false question.

Types of answer choices
In the Types of answer choices pull-down menu, you can choose between Text and Image 
depending on the nature of the answer choices you want to submit to the quiz taker.

Presentation order of the answer choices
By default, the presentation order of the answer choices in the Web version of the question is 
random. If you want to specify a predetermined order, click on Predetermine and place the 
alphabetical or numerical labels in the box in the desired order.
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Edit Index Tab

Under the Statement in the lower part of the window, the Edit index tab displays a column in which you 
can write the answer as well as two columns for indicating the content and respective feedback of the 
answer choices.

Answer column
The Answer column contains radio buttons. You must indicate the correct answer by clicking on the 
appropriate button.

Answer choices column
The Answer choices column contains, by default, the choices True and False, which you can 
replace by the text of your choice. Any characters with an ASCII code higher than 255 will not be 
accepted. Moreover, you should avoid the following special characters: ', ", <, > because they have a 
specific meaning for Web pages. This text zone accepts changes in style. In the Edit Menu of the 
Menu Bar section, check how you can change a style or add Web links and images in this zone.

Feedback column
The Feedback column is used to enter an explanation or pertinent feedback other than Correct 
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answer or Incorrect answer since either one of these is automatically given to the user when an 
answer is checked, whether or not other feedback exists. This text zone accepts changes in style. In 
the Edit Menu of the Menu Bar section, check how you can change a style or add Web links and 
images in this zone.

Web Preview of the Question

Here is an example of the Web preview of a true/false question.

N.B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.

Display of the answer verification
When a quiz taker clicks on the Check button in the floating menu, he or she sees Correct answer 
in green or Incorrect answer in red. Then a green or red dot indicates whether or not the answer is 
correct, and a reminder of the contents of the answer chosen by the quiz taker is displayed as well 
as feedback, if any has been entered for this choice of answer.
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Display of the answer
When the quiz taker clicks on the Answer button in the floating menu, the correct answer is 
displayed as follows: the word Answer followed by the correct answer.

 



18/06/09 10:06 Page 74

BUILDING A QUIZ

To add, modify, delete, duplicate, print, or create the Web version of a quiz, you must be familiar with the 
functions of the buttons in the Quizzes bar and in the Quizzes zone of the Netquiz Pro window.

Quizzes Bar Buttons

On the Quizzes bar located at the bottom of the main Netquiz Pro window, you will find five buttons 
related to the quizzes.

+ Button (adding a quiz)
The + button lets you add a quiz to the quiz bank of the active window. When you click on this button, 
a quiz preparation window appears at the centre of the screen. This window contains the following 
four index tabs: Welcome page, Questions, Properties and Display (for more details, refer to the 
Welcome page, Quiz Questions, Quiz Properties and Display subsections)

When you close this preparation window, a folder icon appears in the Quizzes zone. This folder 
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bears the name you have given it, or, by default, the word “untitled” followed by a number. Under this 
name you will also find the number of questions in the quiz and the total number of points they are 
worth (see the Quizzes Zone section below).

- Button (deleting the selected quiz)
The - button lets you delete the selected quiz in the Quizzes zone. Because this operation cannot be 
reversed, a dialogue box asks you, as a safety measure, to confirm the request for deletion.

Duplicate Button (duplicating the selected quiz)
The button representing two superimposed pages lets you duplicate the selected quiz in the 
Quizzes zone. Duplicating a quiz is a quick way of creating a new quiz that has several similar 
properties to an already existing quiz in the Quizzes zone. For example, in a first quiz, if you have 
adapted or translated the display terms for the Web version of the quiz (see the Display section) and 
you wish to build a second quiz with the same features, it will be simpler to duplicate the first quiz 
and then modify the welcome page and the list of questions of the duplicated quiz.

Print Button
The button representing a printer prompts a menu that allows you to produce a printable version of 
the quiz, to produce a printable version of the quiz answer key, to print the detailed content of the 
selected quiz, to print the detailed content of all the quizzes, and also to print the list of quizzes in the 
“Quizzes” zone. In the first two cases (production of a printable version), Netquiz Pro produces an 
HTML format quiz, basically designed for printing. When the preparation of the printable quiz or 
answer key is finished, a message will ask you to indicate the location of the directory in your 
computer, and then with the aid of a browser this quiz will be displayed on your screen. You will then 
need only to select the “Print” command in the browser “File” menu, or open the “main.html” file from 
Word, in order to modify the layout according to your requirements. In the following two cases 
(printing detailed contents), a dialogue box will ask you to specify the information that you wish to 
print: welcome page, quiz question list or the Display section.

W=> Button (creating the Web version of the quiz)
With the W=> button, you can create the Web version of a quiz. When you select a quiz folder and 
click on this button, Netquiz Pro first checks the questions it contains. If errors are detected, a 
window will appear listing the invalid questions and the reasons they are invalid. You can print this 
list to help you correct the errors.
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If all the questions are valid, a window will appear in which you can choose where on your hard drive 
you want to save the quiz's Web directory. By default, the Web directory' will have the same name of 
the quiz folder, followed by the word “Web”. You can change this name at your convenience. When 
the preparation of the Web version of your quiz is finished, a message will let you know the location 
of the directory in your computer. A formative Web quiz will be created by default. You can check 
locally whether the quiz works by double-clicking on the “index.html” file in this directory.

If you wish to create a summative quiz or a formative quiz with results submitted to server, you 
will need to tick first the desired option under quiz properties (see Quiz Properties), and then click on 
the "w=>" button. The Web quiz directory created by Netquiz Pro will be now accompanied by a file 
with an ".xml" extension. Quizzes with results submitted to server cannot be locally checked by 
double-clicking on the «index.html» file. Use instead the «Web Preview» button in the quiz properties 
window to examine your quizzes before creating them.

To learn how to put your formative or summative quiz on line, refer to Putting a Quiz Online.

Quiz zone

As you create quizzes, they are added to the Quizzes zone of the active Netquiz Pro window.
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To select a quiz, click on the corresponding folder icon.

To modify a quiz, double-click on the corresponding folder icon; the quiz preparation window will 
appear in the centre of the screen (for more details, refer to the Welcome Page, Quiz Questions, Quiz 
Properties and Display sections).

To add questions to a quiz, slide the desired questions from the list of questions table to the required 
folder.
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WELCOME PAGE

The Welcome page tab of the quiz preparation window lets you customize the welcome page displayed 
at the start of the Web quiz. A first section explains how to edit this welcome page and a second 
presents the Web preview of this page.

Editing the quiz welcome page

When you click on the Welcome page tab, the preparation window displays four icons in the heading 
(Image, Audio, Video and Text) and five text fields (Title, Author(s), Institution, Date and Warning).

Image, Audio and Video icons
At the top of the window, four icons are displayed. The first three are used to insert an image, an 
audio clip or a video in the welcome page. In the quiz's Web version, these media files are displayed 
in the centre of the page, one under the other, and below all the other information of the welcome 
page (see the Web preview of the quiz's welcome page section). The image on the welcome page, if 
there is one, is clickable and is used, like the title and the arrow icon preceding it, to start the quiz.

If you want to insert one or more of these media, click on the appropriate icon and click on the 
Choose option of the menu. A box will appear allowing you to select an image, an audio clip or a 
video from the list of media already imported to the MEDIA folder of your question bank. If the image, 



18/06/09 10:06 Page 79

audio clip or video that you want to insert in the welcome page does not appear in the list, you can 
add it by clicking on the + button of the Media box. The button prompts a window which allows you to 
find the media on your hard drive and import it (by clicking on the Open button of the search window) 
into the MEDIA folder of your question bank.

Text icon
To the right of the Image, Audio and Video icons, the fourth icon lets you insert Text into the quiz's 
welcome page. If you wish to add text to your welcome page, click on this icon and a box will appear 
in which you can write a title as well as text.
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The text zone in this window accepts changes in style. In the Edit Menu of the Menu Bar section, 
check how you can change a style or add Web links and images in this zone. In the Web version of 
your quiz, the title and text will appear on the right side of the welcome page under the horizontal line 
(see the Web preview of the quiz's welcome page section).

Title, Author(s), Institution, Date and Warning text fields
The text you write in the Title, Author(s), Institution, Date and Warning text fields is displayed in 
different parts of the welcome page (see the Web preview of the quiz's welcome page section):

- The title is displayed in bold characters at the top of the welcome page. The title and the arrow 
icon in front of it are clickable and are used to start the quiz.

- The authors' names, the name of the institution and the date — by default, the date on which 
the quiz was created — are displayed between the two vertical lines under the horizontal line of 
the welcome page.

- The warning provided by the default text — "This quiz has been created for Explorer 6.0 (or 
later) and FireFox 1.0 (or later) on Windows and for Safari 2.0 (or later) on Mac OS X.” — is 
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displayed in small characters under the title of the welcome page.

Web Preview of the Quiz's Welcome Page

To be able to see a Web preview of your quiz, you must have a browser installed on your computer (e.g. 
Explorer or FireFox on Windows or Safari on Mac OS X). By clicking on the Web Preview button of the 
quiz's preparation window, a directory titled PREVIEW-WEB-TMP temporarily appears on your 
computer's desktop and the window of the welcome page is displayed in the foreground. You 
can click on the quiz's title, the arrow icon or the image on the welcome page to start the quiz. 
Make sure to test all your questions before putting your quiz online (see the Putting a Quiz Online 
section).

Once the preparation window of the quiz is closed, the PREVIEW-WEB-TMP directory 
automatically disappears.

N. B. If you ask for Web previews repeatedly, you may have to refresh the Web page or empty your 
browser's cache in order to display the most recent changes.

The quiz's welcome page comprises the following items in this order:

- A clickable arrow icon used to start the quiz.

- The clickable quiz title used, like the arrow, to start the quiz.
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- The warning written in small characters under the title of the welcome page.

- The authors' names, the name of the institution and the date, if available, displayed between the 
two vertical lines under the horizontal line of the welcome page.

- The video, audio and image media files, if there are any, appearing in the middle of the screen 
page and displayed one under the other. If there is an image, it is clickable and, like the title and 
the arrow icon, it can be used to start the quiz.
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QUIZ QUESTIONS

The Questions index tab of the quiz preparation window lets you see the list of questions that have 
been dragged into the quiz folder. Here you can modify the order and weighting of the questions without 
affecting the same questions appearing in other quizzes.

To modify the order of the questions, click on the line of the question you want to move and drag it to 
the desired location. As long as the Random order box in the quiz's Properties is not ticked (see the 
Quiz Properties section), this order will determine the order of the questions in the Web quiz.

To modify the weighting of a question, click on the corresponding line in the Points column. A box will 
appear in which you can decide on the question's weighting for this quiz only.
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To delete one or more questions from the quiz, click on the corresponding lines in the Delete column. 
An X will appear to let you know these questions will be deleted from the quiz when you close the 
window by clicking on the OK button. Please note that deleting a question from the quiz will not delete it 
from the question bank.
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QUIZ PROPERTIES

The Properties index tab of the quiz preparation window lets you tick options relating to the type of quiz 
and the question generation mode in the Web version.

Type of quiz

You can choose among three types of quizzes: formative, formative with results submitted to server, 
or summative.

Formative quizzes
A formative quiz allows quiz takers to check their answers on line, get feedback, view the correct 
answer to a question (provided the Answer button is available for such question), and look at their 
results page placed at the end of the quiz at any time. 

By default, formative quizzes (without results submitted to server) are compatible with the SCORM 
standard. This means that if you place this type of Web quiz on a pedagogical platform that complies 
with SCORM specifications, the grade for each question and the overall grade assigned to each quiz 
taker will be kept on this platform. If you do not have access to this type of platform, you will place 
your formative quizzes on a Web server. In such case, when quiz takers close the quiz Web page, 
their results will not be saved, unless they are printed. The following two options address this gap.
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Summative quizzes
When a quiz is of the summative kind, quiz takers cannot check their answers themselves, nor view 
the correct answers. When a user goes from one question to the next, his/her choices are 
automatically sent to a results management module (<administrator> folder) that you will have 
created with Netquiz Pro and then placed on the same quiz Web server (see Putting a Quiz On Line 
and Results Management Module). Answers will be checked and the results saved by this 
management module. You will thus be able to derive statistics from quiz takers' answers. Note, 
however, that this type of quiz is not compatible with the SCORM standard.

Formative quizzes with results submitted to server
A formative quiz “with results submitted to server” is a hybrid version of the former two. It combines 
the possibility for quiz takers to check their answers on line, get feedback, view the correct answer, 
view their results (as in the case of the formative quiz), and also to automatically send their answers 
to a results management module (<administrator> folder) placed on the same quiz Web server. As 
in the case of summative quizzes, this kind of quiz is not compatible with the SCORM standard.

When you tick the “Submit to Server” or “Summative” option, the “Management Module URL Address” 
becomes active. Enter the URL address of your management module in this field (refer to Results 
Management Module).

Your quizzes can be put on line in different manners, according to their type. For more details, refer to 
the Putting a Quiz Online section.

Note: Before checking the “Submit to Server” or “Summative” option, it is advisable that you test your 
quiz in formative mode (without results submitted to server) by clicking on the “Web Preview” 
button in the quiz editing window.

  
Generation mode of the questions

By default, the “Random order” option is already ticked. This means that the questions in the Web 
version of the quiz will be presented in random order. If you prefer the questions to be presented to quiz 
takers in the same order as the list of questions under the “Questions” tab, you must leave the Random 
order box unchecked.

The “include all questions” and “[ x ] questions among <total number of questions>" options are active 
for formative quizzes without results submitted to server only, and only if the “Random order” option is 
ticked. The option “[ x ] questions of <total number of questions>” means that each time that a quiz taker 
starts the quiz over, a new subset of [ x ] questions randomly chosen from all the quiz questions will be 
displayed.
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DISPLAY

The Display index tab of the quiz preparation window lets you customize the quiz. You can choose the 
Appearance and the type of Number delimiter, and change or translate the texts appearing in the 
Floating menu, the Feedback section, the Display of results, the Submission form, the Alerts and the 
question Instructions.

To modify the appearance of the quiz, take a look at the different Appearance possibilities listed in the 
table. A preview of the outcome is displayed to the right of the list. You can maximize the preview by 
clicking on it to have a better look. These different Appearance possibilities change the background of 
the welcome page, the colour of the vertical strip and the background of the questions as well as the 
appearance of the floating menu and its buttons. For those with a talent for design, it is possible to add 
new quiz designs by creating in the CONTENT/Appearance directory, new folders comprising files with 
exactly the same names and image formats as the folders already in place. The name of your folder will 
automatically be added to the list in the Appearance table.

To modify the type of number delimiter, click on your preference of either Period or Comma.

To modify or translate the texts appearing in the Floating menu, the Feedback section, the Display of 
results, the Submission form, the Alerts and the question Instructions, all you have to do is replace 
the default text by the text of your choice in the different text fields.
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PUTTING A QUIZ ONLINE

To put your Web quiz on line, follow the applicable procedure depending on your quiz being a formative 
quiz, with or without results submitted to server, or a summative quiz (for more details regarding quiz 
types, see Quiz Properties).

Formative quizzes (without results submitted to server)

There are two possible options to put a formative quiz on line, the first one described below being the 
most frequently used.

1) To put your formative quiz on line on a Web server, you will have to upload the quiz from your 
personal directory on that server by using a FTP transfer software. Quiz takers will then only need to 
enter in their browsers the address of your personal directory, followed by slash and the name of 
your quiz.

For example, if my personal directory address on the Web server is:

http://www.profweb.qc.ca/ccdmd/lucie

the name of the quiz located in my directory will be:

http://www.profweb.qc.ca/ccdmd/lucie/MyQuizWeb

2) By default, formative quizzes without results submitted to server are compatible with the SCORM 
standard. If you have access to a pedagogical platform complying with SCORM specifications, and 
you as a teacher wish to make a follow-up of quiz takers (grades for each question and overall grade 
for each quiz taker), follow the instructions supplied by the platform's institutional owner. Quiz takers 
will also need to follow the instructions related to this platform so as to be registered and have 
access to the quiz.

Formative quizzes with results submitted to server

To put on line a formative quiz for which quiz takers' results will be submitted to a server, you will 
proceed just as if it were a summative quiz.

Summative quizzes

To put on line a summative quiz or a formative quiz with results submitted to server, you need to have 
access to a Web server supporting PHP language and MYSQL databases. If this is the case, follow the 
following steps:
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- Contact your network manager and obtain a user name, database name and password to access 
this database.

- Using the Netquiz Pro software, create a results management module (<administrator> folder): in 
the file menu, choose the “Results Management Module” command.

In the window prompted by this command an instruction explains how to fill the "Database server 
address", “Database name”, “Database user name”, and “Database password” fields with the 
details that your network manager will have provided to you. When you click <OK>, a directory 
under the heading <administrator> will appear on your computer's desktop. (Note: one 
management module will be enough to manage all your web quizzes). 

- Using FTP transfer software, upload the management module (<administrator> folder) in your 
personal directory on the Web server. You will be able to access your management module by 
entering this module's URL address in your browser.

For example, if the directory address on the server where I have placed my results management 
module (<administrator> folder) is:

http://www.profweb.qc.ca/ccdmd/lucie

I will be able to access my management module by entering the following URL address in 
Internet Explorer, Firefox or Safari:

http://www.profweb.qc.ca/ccdmd/ lucie/administrator 
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- Create the Web quiz after having ticked the desired properties (see the Quiz Properties and 
Building a Quiz sections), and enter in the right place the URL address of your management 
module on line. The Web quiz folder created by Netquiz Pro in your computer is now 
accompanied by a file with a ".xml" extension.

- Using the FTP transfer software, upload the ".xml" file accompanying your Web quiz on the "XML" 
directory of the management module that you have previously put on line.

- Refer to the Results Management Module section to learn how to manage quiz takers' access to 
the quizzes that you have put on line, and how to consult individual and collective results in detail.
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RESULTS MANAGEMENT MODULE

You will need to use the results management module if you wish to create summative or formative 
quizzes with results submitted to server (see the Quiz Properties section). This module will let you 
manage users' access to the quizzes that you have put online and consult individual and collective 
results in detail.

To create a results management module, you only need to select the “Results Management Module” 
command from the “File” menu (see details of this command under “File” Menu in the Menu bar 
section). Note: One management module will be enough to manage all your summative Web quizzes 
and formative Web quizzes with results submitted to server.

To put the management module online, follow the instructions described under “Summative quiz”, in 
the Putting a Quiz Online section.

Accessing your Management Module Online

To access your management module online, you need only to enter its URL address in your browser. 
For instance, if the address of my directory on the server is:

http://www.profweb.qc.ca/ccdmd/lucie

I will enter in a browser (e.g., Internet Explorer, Firefox or Safan), the following URL address:

http://www.profweb.qc.ca/ccdmd/lucie/administrator

Accessing your Management Module for the first time
The first time that you access your management module online, you will need to give it a name and a 
password. This name and password may be different from those you have informed to your network 
administrator and entered into Netquiz Pro to create your management module. From now on, this 
name and password will allow you to identify yourself each time you access your management 
module, and will prevent anyone else from having access to your quiz results.
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Accessing your management module in the future
Each time you access your management module, you must identify yourself by indicating your user 
name and password, which you will have informed to your management module upon your first 
access.
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Quiz management 

When you click on the “Continue” button in the identification box, you will access the “Quiz Management” 
page, which contains a list of the quizzes that you have appended to the “XML” file of your management 
module online.
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From this page, you can change the password of your management module by clicking on the “Change 
management module password” button, which is located in the upper right corner of the page (see the 
“Changing Netquiz Pro Management Module Identification” section), add a new quiz to the database, 
change the status (active or inactive) of a quiz in the list, manage a password to access a quiz online, or 
delete a quiz from the list.

Adding a new quiz
To add a quiz to your results management module online, you must follow the steps described 
below:

- By using FTP transfer software, upload the “.xml” file that accompanies your Web quiz in the “XML” 
folder of your management module online (see “Summative Quiz” in the Putting a Quiz Online 
section).

- Then click on “Add new quiz to database”. This button is located on the upper right area of the 
page that contains the quiz list. In the page that will then be displayed, you will see the list of “.xml” 
files that you have placed in the “XML” folder of your management module, and for each of these 
files a status will be indicated ( — or Already added). Click on “Add” for each quiz that you wish to 
add to the database.
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- Click on “Return to quiz list”. This button is located on the upper right area of the page. The 
quizzes that you have added are now listed in the “Quiz Management” page. By default, these 
newly added quizzes are inactive, meaning that users may not access them in order to answer the 
questions. In the following section the way to modify this status is explained..

Changing quiz status (active or inactive)
To put a quiz in active (i.e. accessible to users) or inactive (i.e. not accessible to users) status, you 
need first click on the quiz title in the page containing the quiz list. Then, on the “Consult a quiz” page 
that will be displayed, you need only click on the “Active” or “Inactive” button, depending on the status 
you wish to select.



18/06/09 10:06 Page 96

Managing user password to access quiz
If you wish the access to any of your quizzes to be protected by a password, you will need first to click 
on the quiz title in the page that contains the quiz list. At the bottom of the “Consult a quiz” page that 
will be displayed, you will enter the selected password, and then click on “Accept” to confirm the text 
input. You may modify or erase this password at any time, at your convenience.

Consulting or modifying the results of a quiz 
To consult or modify the results of a quiz, you need first to click on the quiz title on the page that 
contains the quiz list. At the foot of the page “Consult a quiz” that is then displayed, you will see three 
tabs: Statistics, Questions, and Quiz Users. You may go from one to another of these sections by 
clicking on the respective tab.

The Statistics tab provides, in real time, quiz takers' names, the date and time of their latest 
submission, and the average, median, and number of users that have obtained a mark over 60%. 
Warning! At the time these data are consulted, there may be some quiz takers that are still in the 
process of answering the quiz. Statistic calculations may therefore be based on incomplete data.
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The Questions tab shows the list of questions contained in a quiz and provides, for each of them, 
the heading, type, average based on users as a whole (in real time), and weighting. You can export 
these results in the form of a text file, by clicking on the “Export in text format” button. This text file may 
be imported into an electronic spreadsheet, such as Excel, for instance, so that you may process 
data according to your needs. (Note for Macintosh users: the exported text file is coded in ISO-8859-1 
or Windows ANSI format; be sure to configure your spreadsheet properly so that you will see 
characters with their correct accent marks).
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You may get more details on each of the questions by clicking on their respective lines in the table.
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The gray area, on the upper part of the displayed window, contains the question's heading, type, 
statement, number of quiz takers (in real time), weighting, the average mark obtained by quiz takers 
as a whole (in real time), status (active by default), which you may change by clicking on “Annulled” if 
necessary, which you will do after having ensured that quiz takers no longer have access to the quiz, 
by turning the quiz inactive or by changing its password. 

Below the gray area, you are shown each quiz taker's registration number, name, group, date and 
time of his/her latest submission (in real time), the number of points automatically attributed by the 
management module or the number of points that you may change manually, if necessary, which 
you will do after having ensured that the quiz taker no longer has access to the quiz. You may also 
see the answer and feedback corresponding to each quiz taker.

The Quiz Users tab provides the list of quiz takers, and each user's registration number, name, 
group, date and time of his/her latest submission (in real time), and also his/her results as an 
absolute value and as a percentage. You can export these results in the form of a text file, by clicking 
on the “Export in text format” button. This text file may be imported into an electronic spreadsheet, 
such as Excel, for instance, so that you may process data according to your needs. (Note for 
Macintosh users: the exported text file is coded in ISO-8859-1 or Windows ANSI format; be sure to 
configure your spreadsheet properly so that you will see characters with their correct accent marks).

You may get more details about each quiz taker by clicking on his/her respective line in the table.

The gray area, in the upper section of the displayed window, contains the quiz taker's registration 
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number, last name, first name, e-mail address, group number, date and time of his/her latest 
submission in real time, his/her overall result on the quiz (in real time), and also his/her status 
(active by default), which you may change by clicking on “Annulled”, if necessary, which you will do 
after having ensured that the user no longer has access to the quiz, by turning the quiz inactive or by 
changing its password.

Below the gray area, for each question included in the quiz, you are shown the respective question 
number, heading, type, the number of points automatically attributed by the management module or 
the number of points that you may change manually, if necessary, which you will do after having 
ensured that the quiz taker no longer has access to the quiz. You may also see the question's 
statement, the answer provided by the quiz taker, and the corresponding feedback.

Deleting a Quiz
To delete a quiz from the database quiz list, you need only click on the “Delete” button, located on the 
line corresponding to the quiz that you wish to delete, in the page containing the quiz list.

Changing Netquiz Pro management module identification

If you wish to change the password that allows access to your results management module, you need 
only click on the “Change management module password” button, located in the upper right corner of 
the “Quiz management” page, which contains the database quiz list. Then, in the page that will be 



18/06/09 10:06 Page 101

displayed you must enter your old password, then the new password, which you must reenter a second 
time for confirmation. When you click on the “Continue” button, you will return to the starting point.
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ANSWERING A WEB QUIZ

To learn how to access a Web quiz created by Netquiz Pro and answer its questions, follow the 
applicable procedure depending on your quiz being a formative quiz, with or without results submitted 
to server, or a summative quiz (for more details on quiz types, see Quiz Properties).

Access to quiz

The way to access a Web quiz will depend on the type and location of the quiz (Web server or SCORM 
pedagogical platform).

Formative quizzes without results submitted  to server
There are two possible options to have access to a formative quiz, the first one described below 
being the most frequently used.

1) To access a formative quiz on a Web server, users must simply enter on their browsers the URL 
address where the quiz is to be found.

For example, http://www.profweb.qc.ca/ccdmd/lucie/MyQuizWeb

2) If a formative quiz has been placed on a pedagogical platform complying with the SCORM 
standard, users must follow the instructions applicable to this platform so as to be registered and 
answer the quiz.

When a Web quiz begins to run, a welcome page is displayed. Quiz takers must then click on the 
quiz heading or on the image, if any, to move on to the first question.
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Formative quizzes with results submitted to server and summative quizzes
If this is a formative quiz with results submitted to server or a summative quiz, users must enter the 
quiz URL address on their browsers. The first page displayed before the quiz welcome page is a 
registration form. Each of the following fields must be completed with the details required:

- Last name
- First name
- Registration number
- Group number
- E-mail address
- Quiz password, if a password has been specified in your manager (see “Managing user 

password to access quiz”, in the Results Management Module section).
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Floating Menu

The floating menu, which is used to browse the quiz, also varies depending on the quiz type.

Formative quizzes (with or without results submitted of to server)
If this is a formative quiz, with or without results submitted to server, the floating menu, located on the 
left of the screen for each question, contains:

- arrows to go from one question to another, 
- a “Go to question” area, where a question number may be entered followed by enter or return 
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key, 
- the “Check” button, to get feedback on the answer given, 
- the “Answer” button, to view the right answer (if the option “Display the answer” is checked in 

Netquiz Pro for this question), 
- the “Reset” button, to purge answer fields or put answer fields in random order again, 
- the “Results” button, to get a balance of the results for all the questions included in the quiz.

Note: If this is a formative quiz with results submitted to server, each time a quiz taker moves from 
one question to the next, his/her answers are automatically submitted to the results 
management module (<administrator> folder) that you have placed on the server. To have 
their answers to the last question correctly submitted, users must click on the “Results” button 
and then, after they know and print their results, click on “Submit” button that will appear.

Summative quizzes
If this is a summative quiz, the floating menu, located on the left of the screen, contains:

- arrows to go from one question to another (each time that a quiz taker moves from one 
question to the next, his/her answers are automatically submitted to the results management 
module (<administrator> folder) that you have placed on the server),

- a “Go to question” area, where a question number may be entered followed by enter or return 
key, 

- the “Reset” button, to purge answer fields or put answer fields in random order again, 
- the “Submit” button, to indicate that the quiz has been completed and submit the final answers 

to all questions to the results management module.


